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Copyright © 2024 AMETEK CTS GmbH All right reserved. 
Specifications subject to change 

Foreword Thank you for purchasing the icd.control software. 

This user’s manual describes the software tool and contains useful information 
about the functions and operating procedure of the device. 

This user’s manual lists precautions that must be taken during use and contains 
useful information about the functions and operating procedure of the device. 

To ensure correct use, please read this manual thoroughly before beginning 
operation. After reading the manual, keep it in a convenient location for quick 
reference whenever a question arises during operation. 

This manual contains a selection of typical system setup with the correct wiring 
diagram. 
Further information about the technical data, using and handling with the device 
generators, see the manual for these products. 
Generators offering customized features are not explained in this manual. The 
parameter windows for special tests are basically the same as for the standard 
pulses. 

Notes The contents of this manual are subject to change without prior notice as a result 
of continuing improvements to the instrument’s performance and functions. The 
figures given in this manual may differ from those that actually appear on your 
display and screen. 

Every effort has been made in the preparation of this manual to ensure the 
accuracy of this contents. Should you have any questions or find any errors, 
please contact your representative or send an email. 

Copying or reproducing all or any part of the contents of this manual without the 
permission of the company is strictly prohibited. 

Trademarks Microsoft, Windows, Windows 7, Windows 8 and Windows 10 are either 
registered trademarks or trademarks of Microsoft Corporation in the United States 
and/or other countries. 

Other company and product names are trademarks or registered trademarks of 
their respective companies. 

For purpose of this manual, the TM and ® symbols do not accompany their 
respective names or registered trademark names. 

Version This manual is written for icd.control Software version 8.0.0 and higher. 
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1. Introduction 

1.1 Preliminary Remarks 

The icd.control software is operated under Microsoft Windows. 
The manual describes as detailed as possible all the applications of the program that are available for the 
user. Due to the extensive variety, however, not all possibilities and options can be described in this 
manual. The program is subject to change. 
 
Simulation mode as well as the example files included in the delivery allow user to get familiar with the 
software. 
 
It is easy to make your first tests quickly with the Standard Test. The Vector Test is structured so it 
stands to your highest requirements on the most variable test-procedures. 
Let the icd.control test and monitor the immunity of your equipment through the EVENT function and 
automatic reduction of voltage testing according to predefined settings.  
 
The software supports most serial-port and IEEE-bus measuring equipment. 
 

1.2 General 

This software is used for control of continuous wave generators. 
The software works in Windows 7, Windows 8 and Windows 10. 
The name icd.control originates from the English 

”Immunity to Conducted Disturbances” 

The software can produce a test, save it and generate reports. 
The recognition and registration of occurrences / events during tests on the sample (further EUT) can be 
done through the Fail1- and Fail2- connectors located in the back of the CWS equipment (NSG 4070 
excluded), or with the help of external measuring equipment (EVENT). 
Activating of the buttons Stop, Pause and EVENT also produces occurrences/events during testing. All 
occurrences are listed in the report with the topical parameters and can be provided with additional 
commentaries. 
 

1.3 User Requirements 

The user is expected to have an understanding and knowledge about EMC. Within the frame of this 
instruction manual no information is provided with regard to standard testing. Please refer to the relevant 
standard documents for detailed information. 
 

1.4 Technical Requirements 

 

The icd.control program has to be installed on an IBM compatible AT computer. 

Processor     Dual Core or better 

Memory        2 GByte at least 

Hard disk      at least 500 MByte memory available 

Windows™   Windows 7, Windows 8, Windows 10 (32/64 Bit) 

Interface       USB or IEEE 488 Interface card (National-Instruments). 

 
Operating System icd.control 

Windows 7 (32 Bit) X 

Windows 7 (64 Bit) X 

Windows 8 (32 Bit) X 

Windows 8 (64 Bit) X 

Windows 10 (32 Bit) X 

Windows 10 (64 Bit) X 
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1.5 Supported IEEE boards by the icd TEST software by AMETEK CTS 

Single devices are usually operated via the serial interface whereas in configurations of several devices 
the parallel IEEE interface is used. Therefore, the computer has to be equipped with the corresponding 
interface board. 

The following IEEE boards are supported by icd.control for Windows to control the EM TEST equipment: 

Manufacturer Device icd.control 

National Instruments PCI-GPIB X 

 PCMCIA-GPIB X 

 GPIB-USB-B X 

 GPIB-USB-HS X 

 ExpressCard-GPIB X 

 PCIe-GPIB X 

 

This list doesn’t claim to be complete. 

As a standard we highly recommend to use the following hardware: 
IEEE Interface Type PCIe-GPIB of NATIONAL INSTRUMENTS 

 

 

National Instrument Driver 

Install NI-488.2 rev. 15.0 or higher. The use of older revisions may cause in 
software errors. 

 
 

1.6 Hardware setup connection Computer <-> Generator 

A: ) Application of USB interface. 

USB interface “USB B” connector. For data transfer a USB interface is available. The internal RS 232 
interface is converted to USB standard.  
 
Therefore, the user must set the same Baud rate in the device and control software. 
 
Using the USB interface, the user can have EMC problems during burst tests. According to our experience, 
that usually the computer USB port is disturbed by interference’s. Therefore, a high-quality USB cable (USB 
2.0 standard) must be used. 

 
USB cable setup 
The USB cable must be above ground with a 
distance of at least 10 cm. Otherwise the cable can 
be an antenna for the common mode burst pulses 
and will “collect” the interferences. For longer 
distances such as 10 m, it can be too long and USB 
cable is not the best option. An alternative cable 
should be used. 

For filtering the following type of ferrites can be 
used: Kitagawa TR-40-27-15 with 8 windings 

 
 

B: ) Application of IEEE 488 interface. 

Use a general IEEE488 resp. GPIB - cable. 
Connect the instruments. 

 

C: ) Application of Ethernet interface. 

Use an Ethernet cable. 
Connect the instruments. 
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1.7 Computer settings restrictions  

 The following computer settings are mandatory for proper software operation. 

Settings Remark 

Energy safe or Suspend Mode 
must be disabled. 

Windows sets the IEEE interface in the standby mode. The 
software can switch to simulation mode. Problems occur with long 
durations tests, where the PC is idle for a long time. 

Screen safer 
disable 

Screen safer can influence the running program. 

Hard disk sleepmode 
disable 

The access of programs to a hard drive in sleeping mode may be a 
reason for program conflicts. 

Notebook operation 
use mains power 

When the storage battery is low, the notebook will close the 
program and shut down the computer. The test generator stays  in 
remote status with the last voltage and frequency settings, until the 
setup is changed manually on device. 

1.8 Directory Structure of the icd.control Software 

The software shows the following directory structure after a default installation (Windows 10 style): 
 
Program C:\Programs (x86)\Ametek CTS\icdcontrol 
Program Data  C:\ProgramData\Ametek CTS\icd.control 
 

 

  
 The following list of directories shows the default purpose of application: 

Directories icd.control for program data 

Attenuation Files for specifying the attenuation 

Conversion Files for specifying the conversion 

CouplingDevice Files for specifying the coupling devices in use 

Generator Generator configuration files 

Instrument Configuration files for internal and external measuring instruments 

Picture Library for setup pictures 

Result Reports generated by icd.control 

Standard Library for icd.control standard tests 

Directories icd.control for programs 

Media Some media files for internal use 

ProgData Software components  
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1.1.  icd.control Software Install and Uninstall 

1.1.1. Installation 

 
To start the installation, select the routine 
icdcontrolSetup.exe from the software CD or 
USB.   

1. Press Next to continue 

 

 
The installation routine guides you with an easy 
dialogue through the installation procedure. 
During the installation the relevant data will be 
expanded, copied and the user program will be 
installed either in a new or in an existing program 
group. 

 

2. Press the field: I accept the terms of Licence 
Agreement. 

3. Press Next to continue 
 

  
 
 
4. Accept the default Product install path 
 
5. Check the available disk space 
 
6. Press Next to continue 

 

  
7. Press Install continue. 
 
8. Press Finish for terminate the installation. 
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1.1.2. Uninstall 

 

 1.  Start the uninstall procedure in the 
System control and 
 
select icd.control for uninstall 

 
2.  Select  Uninstall for remove installation 
 
3.  Press Next for start the uninstall procedure 
 

 

  
4. Click Uninstall to remove icd.control 
 
5. Click Finish after a successful uninstall 

procedure 

 



AMETEK CTS  icd.control 
 

Operation Manual V 8.0.0 11 / 73 
 

2. Guide to icd.control 

2.1. Software Overview 

1.) Start Windows operating system. 

2.) Start icd.control, double-click on the icd.control -Icon.  

 

  
icd.control main desktop 

 

2.2. Software License 

With the software license you get the access to the full program facilities. 
Each license is associated with one device (by serial number for NSG 4070 and SWN i.e., software 
number for CWS) 
 
Click on General Setup on the top menu bar. 
This is where you enter your license code. If you have finished 
entering your license you will see the SWN code of your 
generator. 
 

 

icd.control without license: 
Without license icd.control runs with it complete functional range but only in simulation mode. That means 
the software may be used for demonstration purposes, file transfer of results, file configurations and 
report generating but not together with a connected generator. 
 
icd.control Licence: 
All functions are accessible. icd.control runs without limitations. 
 

2.2.1. Operating mode 

icd.control works in two different operating modes. 

Test System  

- icd.control has connection to one generator. 
- You can work with icd.control together with your generator. 

 
Simulation 

- icd.control works in simulation mode. 
- icd.control has no contact to a generator. 
- The interface is not or wrong configured (software or generator). 
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2.2.2. Status bar 

Info related to the cursor position                                                                   Actual standard                            Model                       Status  

 

2.2.3. Main Toolbar 

 

Open the standard test manager. 

 

Open a vector test file. 

 

Open a test result in the view mode. 

 

Open the last test result. 

 

Open the general setup. 

 

Open the instrument list for configuration. 

 

Open the device control panel window for manual control of the generator. 

 

Exchange of calibration files for IEC 61000-4-6 edition 3 in combination with CWS. 
The connection with NSG reads the directional coupler data and result files. See 
Chapter 3.2.1 for details. 

 

. 

 

2.3. The icd.control window in the test mode 

 
This is how you recognize the test mode.  
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2.3.1. Test Mode Toolbar 

 

Switching into the view mode and opens the last test result. 

 

Open the general setup. All settings are changeable except of selecting another 
generator. 

 

Open the settings window of the standard. 

 

Export the standard or instrument settings into a pdf or rtf file. 

 

Open the preview window for the standard or instrument settings. 

 

 

This features allows you to manually run the test for each step. The user has to 
click Forward each time to go to the next step. 
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2.4. The icd.control window in data view mode 

You can view the data files about instruments, test 
reports and calibration files. 

 
Test result files are viewed by clicking on “Test 
Result” or “Last Test Result” icons at the top. For 
the calibration data, please see the below 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.4.1. View Mode Toolbar 

 

 

Open a report file in the view mode. 

 

Opens a Calibration file. 

 

Opens an Instrument log file. 

 

2.4.2. View Mode options 

 

 
Save the active window. 

 
Open the settings window of the active window/panel object 

 
Export the settings of the active window/panel object into a pdf or rtf file. 

 
Open the preview window for the active window/panel object settings 
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3. First use 

This chapter will guide you through the configuration menu with a suitable setting proposal for 95% of all 
users. 

Steps for first use 
- Software configuration 
- Performing of a calibration 
- Proceed a test 
- Viewing the results 

3.1. Software Configuration 

Overview 
- Operation mode (Simulation / Connection computer <-> Generator) 
- Device interface configuration and license 
- Break, Fail, Trigger 
- Password setup 
- Miscellaneous settings 
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3.1.1. Device Setup 

 
 
1. Click on General Setup. The Device setup window of the 

system configuration appears. 
 

Select Test System to work with a connected generator 
or  
Simulation to work without a connected generator 
 

To view other settings, click into the listed menu titles. 

Select the correct generator under Device.  

2. Check the IEEE address of the device. 
If necessary, enter it in the field "Address:". 
Default address: 10. Software No should be matching the 
device. For NSG systems, the license is linked to the Serial 
No. 

3. Enter the device Serial number. This number will be used 
for the test report and will be linked to the License of the 
software Each icd license is associated with one device. 

4.  Press the OK button 

 
 

 

3.1.2. Search connected Devices 

 
1. Click on the General Setup button  

2. In the Interface Setup choose the corresponding 
interface and click on Search button 

 

3. The software will automatically search connected 
devices on computers interfaces which 
corresponds to the selected unit. 
 

 

 
 
 
 
 
 

 
Interface Setup for NSG 4070C 
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3.1.3. icd.control Interface 

In the row Address the Interface address, normally IEEE488 device address or Ethernet IP Address, 
needs to be entered. The same address as shown in the display of the related test generator must be 
entered here. This is the address iec.control will search for to communicate with connected test 
generator. The addresses given below show the factory settings. When changing any of this address 
check the related test generator for equal setting of the interface address. Click into field on the right side 
of the device address for open the interface setup and configure the interface.  
See also section 4.1.1 for details on test setup. 
 

A) Using the USB interface 

Now set the Baud rate in generator 

1. Select USB / RS232 
 
2. Choose the COM Port and the Baud rate. 

Factory setting: COM 3, 38400 Baud 
 

3. An Additional Timeout can be used if no answer is 
received from Gen. 

 
 

B) Using the IEEE 488 Interface 

Now enter the IEEE address in generator 

1. Select IEEE/ GPIB 
 

2. Set the IEEE address of the generator 
Factory setting: IEEE address = 10 
 
The option Check STB (Status Bit) allows an efficient 
communication (not supported by all devices) 
 

 
 

C) Using the Ethernet Interface (NSG 4060/4070 only) 

Now enter the Ethernet address in generator 

1. Select Ethernet 
 

2. Set the IP address of the generator 
 
 
 
 
 
 

 
D) Using the USB Interface Option (NSG 4060/4070 only) 
 

1. Select USB 
 
2. Set Vendor ID, Model ID and Serial No. of the Generator 
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3.1.4. Events (Break, Fail, Trigger) 

Set your options according to the graphic at the right.  
This is the easiest way to follow the actions of the software. 
Here you can select Suspend and Threshold features during 
the test and adjust parameters in Auto Threshold 
 
After the occurrence of an event, the software will use the 
auto select values until reaching the defined test 

 

3.1.5. Password Device 

 
If a password is set, then the software doesn’t allow to 
change test parameters without entering the 
password. The software can be used without entering 
the password, but no changes to standard parameters 
are allowed. See also section 4.1.3 

 

3.1.6. Settings 

Set your devices according to the graphic at the right. 
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3.2. Perform a test 

This manual will show you two examples with of tests according to IEC 61000-4-6 and ISO 11452-4. 
Other test examples refer to the special application notes web page of Signal Generator (e.g., NSG 
4070C) 
- Proceed a standard test 
- Execute the test 
- Create a report 
 
Other test routines with icd.control: 
- Vector Test program 
- Device Control program 

3.2.1. Standard Test as per IEC 61000-4-6 

The following pages describes how to proceed an IEC 61000-4-6 standard test with CDN application. For 
detailed screen information of software please refer to the separate chapters at the end of this manual. 

Basic Settings 

Clicking on “General Setup“ opens the generator settings 

menu > Under Device select the appropriate generator model e.g., NSG 4070 

 

If necessary, set limits for the connected hardware. “Power Limit“ limits the forward power. This feature 
avoids a damage in case of error. Based on forward power measurement, the output power is limited 
from the amplifier to prevent any damage. „Output Limit“ limits the output level of the signal generator 
and is e.g. to 0 dBm if the maximum input power of the connected amplifier is limited to 0 dBm. 

For NSG 4070, if the “External Directional Coupler” is selected, it expects the forward power at channel 
2. For operation with the internal power amplifier and internal directional coupler, the checkbox must not 
be set. After finishing settings, click OK 

 

Click on “Device Transfer” to read 
the directional coupler data of the 
NSG 4070 and open the following 
window. 

 

 

In this window, device specific values can be inserted 
according to calibrated results. 

A comment can be inserted or changed in “Description” 

Clicking on “Save” allows the program to assign a file 
name. 

 

 

 

Setup 

1. Click on the Standard Test button in the toolbar to open the standard manager window. 
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2. Select the desired standard group on the left frame.  
IEC EN / Basic / 
Then the stored standard files of the selected standard appear in the right frame. 
 

 
 

3. Select the desired standard EN 61000-4-6 (Edition 4) .nr in the right frame. 
 
Click the OK button to switch to the test windows. 

 
In order to view the test setup, click on View> Show 
Test Setup 

 
 
- CWS 500N1x / N2 or NSG 4070 
- 6dB and 20dB attenuator (as needed) 
- CDN coupling decoupling device 
- 150/50 Ohm and common mode adapter as required 
for the coupling device. (R100N) 
 
This setup can also be used for the first calibration. 
Please look for application notes on the web page for 
more info on setup. 

 
 
  

 
Example of Calibration setup with CDN and 
NSG 4070 with internal amplifier. 



AMETEK CTS  icd.control 
 

Operation Manual V 8.0.0 21 / 73 
 

A) Start a level specific attenuation calibration 

 
1. Select Level I (1V) in the Level array. 
 
2. Select the Calibration tab on top of the window. 
 
3. Select in the field Coupling Device the radio button 

CDN and then the used CDN M3. 
 

4. In the Step field, you can change the step size for each 
frequency change. 

 
5. Select the current monitor. 

Select "internal" if using the built-in power meter of CWS 
500 or NSG 4070. 

 

6. Click  to set the test level setting for the 
connected hardware. 

 
7. In the field, “Level Change each Testpoint”, a value 

of, for example, -6 dB, means the level would be 
lowered by 6 dB at each frequency step and then 
gradually increased to the target level. A level reduction 
may be required by the standard. During calibration 
(procedure for setting the test level) these requirements 
do not usually exist and a value of 0 dB shortens the 
calibration time. When finished, click OK 

 
8. Select the attenuator: In Current Clamp window, a 

double-click into the diagram or a simple click on the 

settings symbol  opens the following menus. 
 
 
 
9. Select the file containing the correction data of the 

attenuator connected on the power meter channel 1 of 
the NSG 4070, e.g. -20 dB for a 20 dB attenuator. This 
file can be supplemented with the attenuation values of 
the connected cable, recommended for long lines. For 
attenuation values, the software expects a minus sign 

before the numerical value. Clicking on the icon  
opens the file. No attenuator was set for this example. 
Click OK. 
Similarly, double clicking on the “Internal Power Meter-
Forward” will allow to set up the settings for the Forward 
Power Meter Coupler used (see also Sec 3.2.1). When 
finished, click OK. 

 
10. In case of external amplifier, see section 6.1.2.3 
11. Press the button Start to begin calibration. 

 
12. After successful calibration, the operator is prompted to 

save the file. 
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B) Start the test 

 
1. Amplifier Saturation Test allows you to test the 

performance of Amplifier and can observe if the 
Amplifier meets the allowed 5 dB tolerance level. 
The standard describes the following: If the 
difference is between 3,1 dB and 7,1 dB then the 
amplifier is in tolerance and the test system is 
sufficient for testing at the selected test level. If the 
difference is less than 3,1 dB or more than 7,1 dB 
then the amplifier is non linear and is not suitable 
for testing. 
 

2. Immediately after calibration and saving the results, 
the program enters the test mode. Make sure the 
tab Test on top of the window is active. 
 

3. As it was done during Calibration, the test setup 
can be viewed by clicking on ”View” -> “Show Test 
Setup”  

 
 

4. Select Dwell Time for the duration for one cycle of 
DUT behavior (at least 0.3s). 

5. Click  to set the test level settings 
for the connected hardware. 

6. In the field, “Level Change each Testpoint”, the 
test level can be changed e.g., -6dB. 

 
7. Press OK and select the Test tab below the 

diagram. 
 
8. Choose a Calibration File. immediately after 

calibration and saving the results, this file is used 
for the test. If necessary, select another calibration 
file. Click on the “i” icon to display the content. 

 
9. “Expert Mode” allows the user to change the test 

criteria as may be needed for the test. 
 

10. In case of external amplifier, see section 6.1.2.3  
 
11. Press Start to begin the test procedure. 

 
 

 
 

 
Example of Test Setup with CDN for NSG 
4070 and internal amplifier. 
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A test with 1s dwell time and 1% frequency step needs 
approx. 12-15 minutes. 
 
Use following buttons: 
 

 to stop the test. 
 

 for break. 
 

 for an event. 
Monitor window allows you to see parameters at each 
step 
 
More information about the function see next chapters. 

 
 
At the end of the test the finish window appears. 
 
12. Enter a comment for the test complete 

documentation. 
 
13. Press Save to save the test. 

 
 

14. The selected report settings can be changed, saved 
or overwritten by loading another .rep file.  
 
Report setting files contains following data: 
- Company logo (max. 256 color .bmp file) 
- Test center and test engineer 
- Customer name and address 
- Tested object 
- Used standard 
- Result with comment 
- Climatic conditions 
- Visible elements for the report 

 
Confirm with OK. 

 

 

 
15. Save the test under a given name. 

The file will be saved with the extension .prj. 

 
  
  
16. The test result file will be quickly available by 

pressing Last Result. 
 
Report functions refer chapter Viewing the results 

. 
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3.2.2. Standard BCI Test as per ISO 11452-4 

The following pages describes how to proceed a ISO 11452-4 BCI standard test with a closed loop 
application. For detailed screen information, please refer to the separate chapters. 
 
Setup 

 
1. Click on the Standard Test button in the toolbar to 

open the standard manager window. 

 
 

2. Select the desired standard group on the left frame.  
Automotive / International / ISO / 11452-4 /  
Edition 5 / Closed Loop 
Then the stored standard files of the selected 
standard appear in the right frame. 
 

3. Select the desired standard ISO 11452-4 (Edition 
5) BCI - Closed loop.nr_ in the right frame. 
 

4. Click the open button to switch to the test window.  

For this first test we propose to use the following test 
setup as shown in the figure (as example) : 
In order to view the test setup, click on View> Show 
Test Setup and you will see the diagram on right. 
 

 
 
 
This setup can also be used for the first calibration. 

 
See also available application notes on the 
web related to signal generator e.g., NSG 
4070C 
 

 

Proceed the setup and calibration procedure 

1. Select Level I in the Level array. 
 
2. Select the Calibration tab below the diagram. 
 
3. Select in the field Coupling Device the injection 

clamp model. 

4. In order to change test parameters, click on  

and in calibration tab, you can adjust as needed.  
 With a value of, for example, -6 dB, the level would 
be lowered by 6 dB at each frequency step and 
then gradually increased to the target level. A level 
reduction may be required by the standard. During 
calibration (procedure for setting the test level) 
these requirements do not usually exist and a value 
of 0 dB shortens the calibration time. 

 
5. Press OK to save settings 
6. In order to change the setting of power meters, click 

on settings icon  in the following window or 
simply double click on the graphs. 
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7. In the Measuring Instrument Settings (as shown on 
right). In the field Attenuation, select the file 
containing the correction data of the attenuator 
connected on the power meter channel 1 of the 
NSG 4070, e.g. -20 dB for a 20 dB attenuator. This 
file can be supplemented with the attenuation 
values of the connected cable, recommended for 
long lines. For attenuation values, the software 
expects a minus sign before the numerical value. 
Clicking on the icon opens the file. 
 

8. In Conversion field, Select the file which allows the 
correction data for current measurement in the 50 
ohm jig, e.g. Linear 50R.cp. Clicking on the   icon 
opens the file. Click OK to save settings. 
 

9. Press Start to begin calibration. 

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
  

 
10. Enter a description and the ambient parameter and 

press Save. 
 
 
 
 
 
 
 
 
 
11. The icd.control will make a proposal for the 

calibration file name. 
 
12. Press Save. 
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Start the test (Closed loop method) 
 
1. Immediately after calibration and saving 

the results, the program enters the Test 
mode. 

2. Select “View“ and “Show Test Setup“ to 
display a sample image for the test setup. 

3. Click  to set the test level 
change setting for the connected 
hardware. 

4. In the field, “Level Change each 
Testpoint”, the test level can be changed 
e.g., -6dB. Also, the Max Power level can 
be set above the calibrated power. 

 
5. Select the Test tab below the diagram. 
 
6. Choose a Calibration File. Immediately 

after calibration and saving the results, 
this file is used for the test. If necessary, 
select another calibration file. Click on the 
“i” icon to display the content. 

 
7. A double click into the diagram of “ 

Current clamp”  or a simple click on the 
settings symbol  opens the following 
menu for selecting the MD 4070. After 
selecting the right options, click “OK”  

 
8. Select Dwell Time for the duration for one 

cycle of DUT behavior (as needed by 
standard). 

 
9. Select the Test tab below the diagram. 
 
10. Choose a Calibration File. 
 
11. Press Start to begin the test procedure. 

For Manual start, click on down arrow 
next to Start and select as shown on right 
side. 
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12. The test starts after a short process. 
 

The topical test point: 

 
FWD, REW and Net power: 

Test bench transfer impedance: Shows 
the current impedance of the test setup. A 
value of 100 ohms represents the same 
ratios as previously calibrated. Values 
above 100 ohms increase the output 
power up to a limit of four times the 
calibrated power. 

 
Point table of calibration file: 

Frequency, level and test point, duration: 
 

 

13. Use following buttons 
 

 to stop the test. 
 

 to break. 
 

 Allows you to place a marker 
to indicate an event during testing.  

 
 

 
At the end of the test the stop window appears. 
 
 
 
14. Enter a comment for the test complete 

documentation. 
 
15. Press Save to save the test for using the data in a 

report. 

 
 

16. The selected report settings can be changed, saved 
or overwritten by loading another .rep file. 
 
Report setting files contains following data: 
- Company logo (max. 256 color .bmp file) 
- Test center and test engineer 
- Customer name and address 
- Tested object 
- Used standard 
- Result with comment 
- Climatic conditions 
- Visible elements for the report 

 
17. Confirm with OK. 

 
 

 
18. Save the test under any name. 

The file will be saved with the extension .prj. 
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19. The test result file will be quickly available by 
pressing Last Result. 

 
Report functions refer chapter Viewing the results 
 

 
 
 

Viewing the results 

1. The viewer window will open and shows the 
following windows: 

- Test report window including: 

- The topical test points. 

- The graph with the power and the indicated 
power limit. 

- The EUT impedance characteristic. 

- Instrument panels with the measured values. 
Within the test point diagram, you can ask for a 
frequency and voltage on the topical cursor position 
by clicking the left mouse-key.  

2. To create a report, press Export for direct save into 
a pdf or rtf file. 
To open a report preview window for printing press 
Preview Report. Reports can be saved into pdf or 
rtf files in the report preview, too. 
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3.2.3. Magnetic Field Test as per ISO 11452-8 

The following pages describes how to proceed a H-Field ISO 11452-8 standard test with a radiation loop 
coil. For detailed screen information please refer to the separate chapters. 
Magnetic Field Test as per ISO 11452-8 
 
Setup 

 
1. Click on the Standard Test button in the toolbar to 

open the standard manager window. 
 

 
 

2. Select the desired standard group on the left 
window. 
Automotive / International / ISO/  
11452-8 / Edition 2, 2016-06  
On the right side the stored standard files of the 
selected standard appear. 
 

4. Select the desired standard  
ISO 11452-8 (Edition 2) Internal-1-3.nr_ on the 
right side of the window. 
 

5. Click to the open button for change to the test 
windows. 

 

For the first test we propose to use the following test 
setup as shown in the figure (as a example) : 
In order to view the test setup, click on View> Show 
Test Setup and you will see the diagram on right. 

 
- CWS 500N3 
- Radiating loop 
- Radiating loop sensor 

 
 
Proceed the setup and calibration procedure 

6. Connect the Radiation loop together with the 
Sensor loop and connect the measuring cable to 
the BNC monitor input plug. 

 
 
 

 
7. Select to the Verify H-Field tab below of the 

diagram to perform a verification. 
 
8. Click to the Start button to begin the verification. 
 
 
9. The message box appears who informs, that the 

supply power line will be switched off. Disconnect 
the DUT if you are running a calibration. 
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10. A window with this verification result appears. 
Click the Save button. icd.control makes a proposal 
for the filename. 

 
 

Start the test 

1. Click on the tab Test and Select Level I in the 
Level array. 

 
 
2. Select in the field Coupling Device the antenna 

model. 
 
3. Select the Current Instrument. 
 
Press Start to begin test. 
 

 

The test will be started after a short process. 

During this process a diagram-window with the 
CWS 500N3 settings opens on display. 

The topical test point will be shown in the main 
diagram. 

Frequency, level and test point number will be 
shown in the bottom status line. 

At the right side is the current instrument  
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3.2.4. Frequency Sweep Test as per IEC 61000-4-16 

The following pages describes how to proceed a Sweep IEC 61000-4-16 standard test. 
 
Setup 

For the first test we propose to use the following test 
setup as shown in the figure (as an example). 
As explained in the tests above, choose the right Signal 

Generator, e.g., NSG 4060 in the  

 
 
 
 
Select right coupling e.g. NSG 4060-1. See picture in 
4.1 
1. Click on the Standard Test button in the toolbar to 

open the standard manager window. 
2. Select the desired standard group on the left 

window. 
Basic / IEC / IEC 61000-4-16 / Edition 2, 2015-12 
On the right side the stored standard files of the 
selected standard appears. 

3. Select the desired standard 
IEC 61000-4-16 (Edition 2) - Sweep.nr_ on the 
right side of the window. 

4. Click to the open button for change to the test 
windows. 

In order to view the test setup, click on View> Show 
Test Setup 

 

 

 

  

 
Start the test 

1. Select Level I in the Level array. 
 
2. Select in the field Coupling Device the CN model. 
 
3. Press Start to begin test. 

 
The test will be started after a short process. 

During this process a diagram window opens on 
display. 

The topical test point will be shown in the main 
diagram. 

Frequency, level and test point number will be 
shown in the bottom status line. 
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3.2.5. NSG 4031 testing for the IEC 61000-4-31 

 This chapter describes the testing procedure of NSG 4031 with icd control software. 
 

Before the test, if the equipment must be calibrated by using the following level setting process. The 
picture  shows the NSG 4031 with build in power amplifier. Calibration is recommended to be done on the 
device.  

  
 For testing, the following test set up is applied after calibration. 
 

 
 
As first step, start the icd control software, select the NSG 4031 under the Device option of General 
Setup. Then choose the correct standard under the Standard Test option. 
1) Select the Frequeny range for the test 
2) Choose the Dwell time 
3) Select the required Level 
4) The coupling device is selected by defaul 
5) Click on Start . 
6) After the test is finished click on Save to store the results. 
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3.3. Other test applications 

3.3.1. Vector test 

1. Click on the Vector Test button in the toolbar to open the 
vector editor window. 

 
 

2. The insert window for the definition of the test process parameters appears. 
 
The vector test is always based on the active standard displayed in the window and on the 
bottom of the icd.control desktop. Another reference standard can be selected with the standard 
manager. 
 

         
 
 

 
 

3. Change the test parameters by Edit or Insert. 
 
Note: At least one Vector must be active, so it can be shown 
in the diagram and be used for the test. Switch on the option 
field Enabled. 
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3.3.2. Device Control Panel 

1.  

Click on the button Device Control on the menu bar. 

 

2. The window with the panel for 
manual control appears. 

3. In manual operating mode the 
user can operate the selected 
device 

 

 

 
 
Restrictions by operating with the Device Control Panel: 
 
- The panel does not use any calibration file of a coupling device. 
- The measured instrument value is not matched with a transfer impedance of the measuring device. 
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4. File 

The setup menu offers different menus for configuring the software to the system. The configuration is 
available on the main desktop. 
 

 

New: Lets the user to create new 
 configuration files such as report settings, 
 coupling device, instruments, attenuation 
 and correction files 
Open: opens existing configuration files for 
 editing. 
 
Report Setup: Opens the report setup 
 
Exit: Closes the software 

4.1. General Setup 

The configuration fixes the basic adjustments of icd.control. It can only be activated if there is no test 
window open. The configuration dialogue creates a file with the name icdcontrol.ini in the installation 
directory. 
 
Choose the topic of interest from the list. With the 
first start this will be the topic “Settings”. 
 
Settings 
Device 
Events 

 

4.1.1. Settings 

 
Mode: 
When opening a test file, icd.control tests whether the communication with an attached instrument is 
possible. In case that icd.control finds no instrument it switches automatically to the operating mode 
”Simulation”. 
 
Simulation: 
You can simulate the icd.control without a connected instrument. Of course, all the functions which are 
based on a connected instrument are not available anymore, i.e. the loading of calibrations files. 
Test System: 
The icd.control communicates with the connected generator. 
 
Show Communication Monitor: 
Enables or disables the interface monitor. The monitor is a helpful tool for interface analysis in case of 
troubleshooting. The window size can be adjusted as needed. 
 
 
 
 
 
Show Startup Window: 
If this option is enabled the icd.control opens the Startup Window every time when the icd.control starts. 
 
Show all Standards: 
If this option is disabled (recommend) the Standard Manager shows you only the appropriate standards 
to the selected generator. 
If this option is enabled all available standards will be displayed. 
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Sound at Event: 
As soon as the test is finished, an acoustic signal will be given (Fail, Stop and Limit). 
 
Show Powermeter Underflow Warning (CWS500x only): 
Should the expected measuring signal be lower than the specified noise floor of the power meter a 
warning will appear to prevent of wrong measurements. 
 
Show Maximum Power Warning: 
If the generator reaches its maximum power the icd.control shows a warning message, which can be 
suppressed by this option. 
 
Report after Test: 
Will configure the behavior of the report after the test. 
There are three possible settings: 
- Open manually 

After the test has finished the test window will be closed and the report has to be opened manually 
from the menu bar. 
 

- Auto Print Preview 
After finishing the test a window will open which shows the print preview. 
 

- Auto Export to PDF/RTF 
The report will be automatically exported to a PDF or RTF file. A dialog will appear to enter the 
desired file path. 

 
Unit Calculator Path: 

Press to the field  to find the path the desired Unit Calculator. This program will be executed if the 
menu entry Help -> unit.converter is pressed. 

4.1.2. Device 

Click on drop down under Device and Select 
the correct generator from the device list. 
 

 
Interface 

 
Shows information’s about the actual configured communication interface. 
 

 
 
Setup: 

A click on the button “ ” opens the Interface 
Setup window. An example of Interface setup 
for NSG 4070C is shown on the right side. 
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Definition of the communication interface GPIB, USB/RS232, Ethernet, USB. 
 
GPIB: 
If you run an IEEE 488-card in your computer, choose this set-up. The IEEE address will be set in the 
Device setup screen. 
Test the correct function of your IEEE-card using the analysis tools attached by the manufacturer of the 
card. (Hardware and software test program). 
 
USB/RS 232: 
USB communication or RS232 communication through a 9-pole cable, not crossed. 
Using the USB/RS 232 interface the selected COM port and baud rate will be displayed. 
 

 
Ethernet: 
Communication through a Ethernet cable. 

 
IEEE setup: 
Actually, EM TEST supports the cards manufactured by National 
Instruments. 
 
The option Check STB (Status Bit) allows an efficient 
communication (not supported by all devices) 
 
Card configures the corresponding card address of the installed 
National Instruments GPIB adapter. The actual address may be 
obtained from the National Instruments card driver configuration 
software “Measurement & Automation Explorer”. 
 
Device address by using a IEEE-488 card. 
Enter the correct IEEE-address of your Generator. Values from 1 to 
30 are allowed. 
 

 

USB / RS232 setup: 
Interface COM: Choose the used COM interface. 
Baud rate: Make sure that the baud rate in the Generator 
corresponds to the one set in the icd.control. 
 
Additionally, the Parity Bit, Data size and number of Stop Bits can 
be set. 

 
 
 

Ethernet setup: 
Select the used Ethernet protocol TCPIP. 
IP Address: Choose the IP address of the generator. 
 

 

User with more than one generator 
The icd.control Software can handle different generators. The different generators can be connected to 
the same IEEE interface network, but only one generator can be served. For change the model select the 
model in the device setup. After change the generator model exit and restart the icd.control software. 
 
Serial number 
Serial number is only used for the report. 

4.1.2.1. License 

 The license field was explained earlier in the icd software setup section. 
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4.1.3. Events 

Defines the reaction of icd.control in case of a 
hardware Fail2 or software Trigger. An 
example on right side is shown for NSG 4070C 
 
Suspend Test Run 
If you check this box, the test will stop at all 
those events. Otherwise, the test will continue 
as by defined parameters. 

 
 

 
Auto Threshold (reducing step: -3dB / Increasing Step +1dB): 
If the Auto Threshold value is set, then at the occurrence of a Trigger event, the output will be reduced 
by -3dB steps till the fail disappears or the output level reaches the minimum power. Thereafter the 
output will increase till the fail2 will appear again. Then icd.control will continue with the next step 
frequency with the original set output level. 
 
After each Fail2/Trigger, icd.control continues with one of the following procedure: 

Continue: The test frequency will be changed to next test point. 

Repeat: The actual test point will be repeated. 

Stop: The test will be stopped. The stop dialogue appears. 

 

If the parameter Reducing Step is set to 0, then if a trigger is occurred the next frequency will be tested 
directly. 
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4.2. Report Settings  

The standard report configuration has the advantage for fill out all standard forms of the automatic 
generated report. This will save a lot of time to generate the reports in future. 
 
Choose menu File -> Report Setup 
 
This will open the form for enter the default report information. 
Fill out the blank fields if there is always the same entry. 

 
  
Logo File: Company logo for print 
on the first page. File must be in the 
BMP format. 
Test Center: Address of the test 
house 

Test Engineer: Name of the person 
who is responsible for the test. 

Customer: Customer Address 

Test Object: Test object 
description 

Standard: Normally the applied 
standard is automatic insert into the 
report. 

Port Description:  The description of the EUT port. 

Comment: Comment to the test 

Testreport No: May be the first letters of the report number (date). After the test the user can 
complete the report number.  

Date of Test: This field will be automatic set from the computer internal date and time.  

Result: Default setting will be automatically overtaken in each report. 

Temperature: Actual temperature 

Humidity: Actual humidity 

Pressure: Actual pressure 

Setup Picture: If activated, a picture of the test setup will be inserted into the report. 

Events: If activated, the events may be occurred during test will be listed in the report. 

Test Points: If activated, a list of each test point will be inserted into the report. 

Instruments:  Allows option to show the instrument values in different ways. 

4.3. Password Setup 

 
This setup has the following functions: 
- Change of the password 
- Enable/ disable the Password dialogue at the startup 
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Using a password can protect to overwrite test files. 
 
Number of Passwords:  There can be used only one password. 
Procedure: Once the full access mode is protected by a password you must use this 

password at the beginning of each full access session. In the other case the 
software continues working in the low access mode. 

 
Full access mode:  Changing and saving all files is possible. A password is merely wanted, when 

defined before. In case there is a password defined and not entered, only the 
low access mode will be accessible. 

Reduced access mode: (Low Access): Test- and calibration files cannot be saved. All other functions for 
testing are available. 

 
Forgotten password: The icd.control software must be newly installed. 
Password changes: The password can only be changed in full access mode in General Setup menu 
Disable password: To disable a password make no entry in the field new password. 
 

Change the password 
1. Enter the valid password. If no password exists, press the Enter key 
2. Enter the new password, 

Press Enter. 
3. Confirm the same password; Press OK 

 
4.3.1. Password Setup 

Show Password dialogue at start-up 
switches the password log-in dialogue on or off 
when starting the icd.control software. 

 

4.4. Measure Instrument 

see chapter 8 

4.5. Attenuation File 

The attenuation is the decrease in transmitted signal power resulting from the insertion of a cable or used 
attenuators. It is usually expressed relative to the signal power delivered to that same part before 
insertion. Insertion loss is usually expressed in decibels (dB). 
A certain amount of signal will be lost as it travels through coaxial cable. This loss is dependent on two 
factors: the type of cable used, and the frequency of the signal being carried. Losses are greater at 
higher frequencies; therefore loss compensation should be made at frequencies higher than 200MHz. 
 
icd.control software compensate the insertion loss in the measuring cable in function of the frequency. 
The insertion loss of a measuring cable is stored in the insertion loss file *.los. 

4.5.1. Create a new Attenuation File with manual data input 

 
1. Select the menu  File / New / Attenuation 

 
2. An empty window appears, where you have the 

possibility to enter the insertion loss data of the 
cable or define used attenuators in front of the 
measuring channel. 
 
Format: xxxx.xxxMHz yyy.yydB 
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3. Enter the data into the table in the following 
mode: 
Frequency[MHz];  TAB or space; loss value[dB] 
Continue until the list is complete 
 

4. Enter the Description (cable type and length) 
 

5. Click to Validate Data for drawing the graph in 
the diagram window. 
 

6. Select the save icon and enter the filename  
 

7. The file will be stored with the extension *.los 

 

 

 

 

4.5.2. Create a new Attenuation File with data input from txt file 

Much easier is to create an insertion loss file from a file like you can get from network analyzers. This file 
must have the following data format: 
 
Frequency [Hz]    TAB (as separator)    loss value [dB] 
 
Example: 
9000 → -2.97550577670336E-02 

9144.9462890625 → 1.83761510998011E-02 

9292.2265625 → 1.77272483706474E-02 

9441.87890625 → 1.87315847724676E-02 

9593.94140625 → 3.77311147749424E-02 

9748.4521484375 → 4.12851050496101E-02 
.. 
. 

icd.control will automatically convert this data into the correct form 
 
Procedure for make a new attenuation file from a text file 
 
1. Select the menu  

 File / Open / Attenuation 

 
 

2. Select the filetype: Import txt file[Hz] tab [S21dB] (*.txt) 
This file is created by a network analyzer using the 
parameter S21. 
 
Note:  For more information about the S21 parameter  
  refer to your network analyzer manual. 
 

3. Select the file you like to convert into an insertion loss file. 

4. Press open for create the insertion loss file. 

 
 

A new window opens with the converted data and graphic 
display. 
 
5. Enter the Description (cable type and length). 
 
6. Select the save icon and enter the filename. 
 
The file will be stored with the extension *.los. 
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4.6. Setup Conversion 

The conversion reflects the frequency behavior of a connected current probe. This data must be taken 
from the used calibration certificate. icd.control offers a list of current probes, calJig and other sensors. All 
this data are approximative data from the device used by EM Test/ TESEQ.  
 

 

For correct measurement it is mandatory to adjust the installed transfer 

impedances with the calibrated data from the used probes. 

 

4.6.1. New conversion file 

 
1. Select the menu 

 File / New / Conversion 
 

 
 

2. Select the unit of your frequency steps. 
 

3. Select the unit of the transfer impedance 
This unit will be displayed later in the parameter list and 
as title in the graphic. 
 

4. Enter the Description ( device and serial number ) 
 

5. Enter the data into the table in the following mode: 
Frequency [kHz / MHz];  TAB or space; value[unit] 
Continue until the list is complete 
 

 

6. The file will be stored with the extension *.cp  

4.6.2. Edit or open a conversion file 

 
1. Select the menu  

 File / Open / Conversion 
 
2. Select the transfer impedance file you like to Open or 

Edit for modify. 

 
3. Select the transfer impedance file you like to Open or 

Edit for modify. 

4. Select the parameter at the desired frequency for modify 
the value according the actual used transfer impedance. 

5. Change the description if necessary. 

6. Select the save button and enter the filename and save 
the file as .cp file 
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4.7. Setup Coupling Device 

A coupling device file describes the parameters and behavior of each individual coupling device. During a 
calibration icd.control software takes all information from this file ( exception CDN calibration of *.cdn 
files). Also, the used frequency information for a frequency range check will be taken from this file. 
If the user expands the range of used coupling devices it is necessary to make a file with the information 
about the new coupling device. 

There are four different types of coupling devices. The user can separate the type of coupling device 
from the extension. 
 

Extension Coupling device 

*.1xx CDN 

*.2xx Clamp, Striplings, Cells 

*.3xx Devices for CWS 500N3 model 

*.4xx Devices for CWS 500N4 / NSG 4070 model 

4.7.1. New coupling device 
 
1. Select the menu  

 File / New / Coupling Device 

 
 

2. Fill in the parameters of the coupling device and safe the 
file. 

 
 

4.7.2. Open coupling device 
 
1. Select the menu  

 Setup / Open / Coupling Device 
 
2. Open the coupling device you like to modify. 

 
 

3. Change or modify the parameters of the coupling device 
and save the file. 
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5. Standard Tests 

The standard tests manager shows all programmed standards you can test with your connected 
equipment. 
 

A device specific routine filters the applicable 
standards for the devices: 
- CWS 500 C series 
- CWS 500 D 
- CWS 500 E 
- CWS 500 N1 
- CWS 500 N2 
- CWS 500 N3 
- CWS 500 N4 
- NSG 4060 
- NSG 4070 series  

 

5.1. Benefit of the standard tests manager 

The manager organizes the tree structure of the different standards. It looks like the Windows Explorer 
but reduces the activities to the necessary one. 
The standard tests manager is responsible for the basic setup according to the selected standard. 
You can organize your one standard tree according to your demands. It is based on the file and folder 
structure in the ...\icdcontrol\Standard\ directory. For creating folders or copying files between folders, you 
should use a file manager. 
 
I.e. you can create folders with the necessary test’s for all of your Product’s. 
 

 

This tree was created by using a file manager 
(Windows Explorer).  
Example: Create a structure in the standard folder of 
the icd.control, as follows 
 
                             [..\ icdcontrol \ Standard] 
Create sub folder:     [Products] 
Create sub folder:            [TV] 
Copy from IEC                        EN61000-4-6 
                                                EN55020 loudspeaker 
                                                EN55020 input output 
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5.2. Using the standard test manager 

 
1.) Open it with a click on  

     
 

  
Select and double click on a standard or click OK. 

5.3. Favorite standards 

The last 26 standard tests are listed on the desktop for quick selection. 
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6. Test 

The procedure for a standard test application includes the following steps: 
 
Action Remarks Window 
   
Standard selection Loading the standard test from the standard 

manager. 
Standard Manager 

DUT Parameter setting - Test Level 
- Frequency step 
- Dwell time 

Test  

Setup - Coupling device 
- Port selection 
- Calibration file of the used coupling 

device 
- Measuring instrument  

Setup  

Calibration (if no cal file exist) - Create a calibration file Calibration 
Check the setup -  Setup 
Start the test -  Test 

 

6.1. Test definition window 

This window delivers the information about the test procedure. All modifications of the test parameters 
are selectable in this window. 
 

 

 

A test can be start when the following conditions are ok. 

- The focus of the program shows to the test definition window  
(click in the window to activate) 

- Field above the setup button is green colored (click to the setup button and adjust the 
setup) 

 

 

6.1.1. Areas in the Standard control window 

 

Areas in the standard control window 
 

1 Procedure selection 
2 Applied standard 
3 Parameter field 
4 Modulation control 
5 Control box for breakpoints, amplifier 

and instrument switch 
6 Diagram window 
7 Level control 
8 Test time overview 
9 Coupling device 
10 Used coupling device calibration file 
11 Used measuring instruments 
 

 



AMETEK CTS  icd.control 
 

Operation Manual V 8.0.0 47 / 73 
 

 

Areas in the standard control window 
 
1 Procedure selection 
2 Applied standard 
3 Parameter field 

1 Procedure selection 

Enables the customer to switch between the procedures Test and Calibration. If specified in the 
corresponding standard also Amplifier Saturation Test, Source Impedance and Verify H-Field are 
displayed. 
 
2 Applied standard 

Name of the applied standard with reference to the version and date of the standard. This standard is 
also displayed in the information line at the bottom of the icd.control window. 
 

3 Parameter field 

 

Selectable parameters (input box)  
For adjust the test parameters to the DUT 
behavior. 

 
Frequency :  
Range of the selected standard. The default value equals to the frequency range specified in the actual 
standard. For development and analysis purposes the range can manually be limited. 
 

 

The limited active range which will be tested is indicated by red 
markers above the diagram. 
 

➔ The limitation may easily be changed by clicking moving 
the red marker. 

 
Step : Frequency step between two frequencies. A change of this parameter will change all 

 vectors related to this standard which are not customized vectors. 
- % : Step in percent based on the previous applied frequency. 
- MHz / kHz : Fix frequency step between each frequency. 
- points/decade : Points per decade. Number of frequency steps per decade. 
 
Dwell Time : Application time of the interference signal to the coupling device. 
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Areas in the standard control window 
 
4 Modulation control 
5 Control box for breakpoints, amplifier switch 

 

4  Modulation control 

 

Some standards recommend different 
modulation modes for the test. A list box 
allows to select from all necessary 
modulation modes. 
 
AM1kHz80% :  Amplitude Modulation 1kHz 
80% 
CW :   Continuous Wave 

The modulation control changes only the 
active vectors! (See vectorlist) 

 
5 Control box for break points, amplifier and instrument switch  

A breakpoint will interrupt the actual test procedure for modify the test setup or test equipment. For 
generate a breakpoint the user has to click to one of the triangle buttons left side of the diagram window. 
icd.control offers different kind of breakpoints with the following meaning. 
 

Picture Color Breakpoint Remark 

 

 

yellow 
 

blue 
 

green 
 

 
create breakpoint 

 
blue: - Instrument switch 
yellow: - Amplifier switch for change amplifier 
green: - User defined during the test or 
 - Coupling device for calibration and test 
 

 

 
yellow 

 
Amplifier switch 

 
Change automatically between two connected amplifiers 

 

 
green 

 
Universal 
Breakpoint 

 
A user defined breakpoint who breaks a test. If the option 
“Calibrated setup change” is active the program makes a 
break during a calibration procedure for change coupling 
devices. 

 

 
blue 

 
Instrument switch 
 

Breakpoint for changing one of the measuring instruments in 
use for either the calibration or test. 
 

 

 
olive 

 
Standard defined 

 
Breakpoint is defined in the standard procedure for modify 
the test setup. User can’t create or delete this type of 
breakpoint. 

 

 
red 

 
Frequency sweep 
limiters 
 

 
Markers for limiting the test frequency range. 
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Areas in the standard control window 
 
6 Diagram window 
7 Level control 
8 Test time overview  
9 Coupling device  
10 Used coupling device calibration file  
11 Used measuring instruments 

6 Diagram window 

 

The diagram window shows the selected standard test 
vectors. If more than one level is selected, each level 
is displayed and marked as a separate vector.  

The range setting is controlled by the icd.control 
software. 

During the test icd.control will display the diagram with 
the applied and measured test points. 

7 Level control 

 

Some standards offer different levels for testing. 
Select the desired standard level for testing. 
 
Note: Only one Level at a time can be selected. 

8 Test time overview 

 

Display of the number of steps for the complete test procedure. 
The approximate test time is calculated from the number of steps and 
the test duration with a certain time for communication and generator 
setting. 

9 Coupling device 

 

Indication of the actual applied coupling device for 
the test. The icd.control software cannot check if the 
correct coupling device is selected  

10 Used coupling device calibration file 

 
Indication of the actual used calibration file.  

11 Add Monitor  

 

Allows you to select monitoring options from a list of 
already selected devices. 

 

12          Used measuring instruments 

 
List of the used measuring instrument. 

 

6.1.1. Other functions in the Standard control window 

With the menu Setup Standard the user can modify standard related settings. There are different 
settings available. 
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Standard related settings: 

Level Change at each Testpoint 
Before changing to the next frequency, icd.control 
reduces the power of the applied signal. After the 
measurement icd.control calculates the next values 
to apply the signal in a tolerance of +10% -1%. 

Max Regulation Step 
Max output change during regulation. 

Regulation Step Delay 
Pause between each regulation step. 

Power max limit 
icd.control will limit the maximum power at the 
value Pcalibration + setted value [ dB ] 

Fix current limitation 
Max. allowed rf current. Limitation at this level. 

Additional Level Offset 
Adds an additional offset to the configured test 
level. The resulting test level will be calculated as 
follows: Vector level + additional offset. 

Fast Test Run Mode (IEC61000-4-6 Ed. 3 only) 
Improves the run mode to achieve the shortest 
possible test time. 

Default 
Reset of the values to the default standard 
settings. 

 

6.1.2. Breakpoint 

A breakpoint will interrupt the actual test procedure for modify/change the test setup or test equipment. 
icd.control offers different kind of breakpoints with the following meaning. 
 

Picture Color Breakpoint Remark 

 

 
yellow 

 
Amplifier switch 

 
Change automatically between two connected amplifiers 

 

 
green 

 
Universal 
Breakpoint 

 
A user defined breakpoint which breaks a test. If the option 
“Calibrated setup change” is active the program makes a 
break during a calibration procedure for change coupling 
devices. 

 

 
blue 

 
Instrument switch 
 

Breakpoint for changing one of the measuring instruments in 
use for either the calibration or test. 
 

 

 
olive 

 
Standard defined 

 
Breakpoint is defined in the standard procedure for modify 
the test setup. User can’t create or delete this type of 
breakpoint. 

 
Create a breakpoint 

For create a breakpoint click into one of the triangle buttons left side of the diagram window. A window 
appears for enter the frequency and other parameters. 
 

 

 

yellow: - Amplifier switch for change amplifier 
 

blue: - Instrument switch 

green: - User defined during the test or 
 - Coupling device for calibration and test 
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Edit or delete a breakpoint 

 

Select Edit Breakpoint with a click on the right mouse button 
to the triangle in the graphic window. The edit field appears, 
and the user can modify or delete the breakpoint. 

Note: With a left mouse click you will move the breakpoint 
frequency. Therefore, it is necessary to click with the 
right mouse. 

6.1.2.1. User defined breakpoint 

The user defined breakpoint breaks the test at the selected frequency. 
 

 

A window appears on the screen with the entered 
message.  

Click into OK button to continue the test. 

 

User defined breakpoint  

6.1.2.2. Setup Change breakpoint 

The user defined setup change breakpoint breaks during the calibration and test at the selected 
frequency. The user can change the setup (i.e. coupling device) at this break. 
To create a setup change breakpoint: 
1. Create a user defined breakpoint. 
2. Click the field “Break for setup change”. 
3. Enter your comment into the comment field. 
 

 

A window appears on the screen with the entered 
message. 

Click into OK button for continue the test. 

 

User defined setup change breakpoint  
 
Note:   
To recognize the two coupling devices in report, the user has to create a new coupling device file where 
both coupling devices are described. This new coupling device must be selected in the test setup. 
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6.1.2.3. Breakpoint for amplifier switch 

A breakpoint for amplifier switch will change the used amplifier. 
 
Amp 1 = internal built in amplifier 
Amp 2 = external amplifier 
 
icd.control will change the amplifier and continues with testing with no break. 
 

 

With the external amplifier the user expands 
the frequency- or power range of the 
generator.  

The Amplifier switch change the RF signal 
between the internal and external Amplifier.  

It is important, that the calibration happens 
with the correct amplifier.  

  
 

 

 
For frequencies higher or equal the 
displayed frequency, icd.control will switch to 
the selected amplifier. 
 
 

The external amplifier is marked with 
Ext.Amp at the bottom of the window. 

 

The user can also use the SW 4070 switch 
and use external amplifiers with switching 
function. 

 
 
In order to make a change in setup, such as Band change of amplifiers, user can access the filers 
C:\ProgramData\Ametek CTS\icd.control\Instrument and make necessary changes. 
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6.1.2.4. Instrument breakpoint: “Directional Coupler” 

In case of changing the amplifier during the testing, it is convenient to change the measurement 
instrument for the forward and reverse power by adding and instrument switch and choosing a directional 
coupler. The losses for the forward path can be chosen. The software will change the power meter 
reading for forward and reverse power to channel 2 and channel 3, respectively. 
In case a current loop is used e.g., in IEC 61000-4-39 LF standard, the forward power will be measured 
using channel 3. 

6.1.2.5. Standard defined breakpoint 

Standard defined breakpoints are generated direct from the icd.control software. It is not possible to 
eliminate the breakpoint. 
The test will stop at the breakpoint frequency for modify the test setup according to the standard. 
Click OK to continue the test. 
 

6.2. Test setup configuration 

 
 
Coupling Device: 
 

 

Selection of the coupling device 
The properties of a coupling device is defined in a file with the 
extension 
*.1xx : CDN  
*.2xx : CLAMP, Stripline 
*.3xx : Coupling devices (CWS 500N3) 
*.4xx : Coupling devices (CWS 500N4, NSG 4060) 
You can edit this files with a standard file editor. 

 
Frequency range check status 

 

This indicator here shows if the frequency ranges of the test 
match with the calibration file and the used coupling device. 

 Calibration file and coupling device matches with the test. 

 You cannot start any test because of a frequency 
mismatching. 

 

A click on this indicator Shows the range check diagram with 
frequencies of : 
 Test file 
 Calibration file 
 Coupling device 
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Calibration file: 

 

Select a calibration file. 
Note :The calibration method is selected in the File type  
 *.cal  : Calibration files with power meter 
 *.cdn : Calibration files 
The calibration file has to be in the corresponding standard 
directory.   

 

 Shows the data of the selected calibration file. 
 
The list with all individual calibration measurements is attached at 
the bottom of the diagram. 

Tab Calibration Opens the calibration window to create a new calibration according to 
the standard and the current test parameters.  
This calibration will be executed according the description in the 
standard.  
 

Measuring instruments 
 

 
 
 

 

icd.control will display automatically the necessary measuring 
instruments for the test. In general, icd.control will use the internal 
instruments. 

- Facultative instrument for this test setup 
 
- Parameter file for the selected external instrument 
 

  
 Select an instrument from drop-down-

list 
 

 
  

 Shows the instrument setup  

 

6.2.1.  Current clamp selection 
For using a current clamp, icd.control must be adjusted to the transfer characteristic of the installed 
current clamp. icd.control offers a wide range of different probe characteristics. Most transfer impedances 
in the software are typical curves of used probes. To adjust please refer to the original calibration data 
and match the curve to the used current probe. 
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For selecting the used current probe proceed the following steps. 
 
1. Select the used measuring instrument 

– use internal  
– external instrument according the table 

 

2.  Click to the button  for open the instrument setting window 
 

3.  Click to the Button   for open the drop-down-list and select the transfer impedance file for the 
used current probe. 

 
4.  Press the button OK for close the window 
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6.2.1. Setup as per IEC 61000-4-6 for CDN and clamps 

For the setup for testing according IEC 61000-4-6 and other standards with relation to this basic 
standard, the user has to select the right coupling device. 
 

  
 
 
 
Coupling in to Select the button for coupling device 

 - Clamp:  Clamp or BCI 
 - CDN: Coupling decoupling network 
 
Select the coupling network out of the offered list. 
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6.3. Calibration Window 

 
 
Start calibration Start button for the calibration. 

Remark:  After finishing a calibration successfully the tab 
changes automatically to mode test. 
Afterwards a test may be started without 
modifying any parameter. 

 

 
Parameter fields The parameters are defined in the test window 

or in the coupling device file 
 
Calibration frequency range and frequency step 
 
 
Coupling device  
Calibration instruments 

 
 

 
 
 

 
 
Frequency range 
check status 

 

 

This indicator here shows if the frequency ranges of the test match with the 
calibration file and the used coupling device. 

 :The coupling device matches the calibration frequency and level. 

 :You can not start the calibration because of a frequency mismatching. 

 A click on this indicator Shows the range check 
diagram with frequencies of : 
 Calibration file 
 Coupling device 
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6.4. Window during a test 

 

 

Areas in the test window 
 
1 Control buttons 
2 Test point window 
3 Power window 
4 EUT impedance window ( only if recommended) 
5 Calibration file information 
6 Test parameter/status information 
7 Instrument 1 : Forward power * 
8 Instrument 2 : Reverse power * 
9 Instrument 3 : Current clamp * 
 
* The number of instruments depends on the test setup 

 

Measuring values 

The actual measured values are marked during the test. The test 
frequency and measured values are displayed on the right side 
above the window. 
The same happens by clicking the mouse in the window. 
 
 Measuring point with related data 

 

Edit measuring parameter window 

During a test it is possible to change the parameters of the 
measuring instrument. After closing this window, icd.control 
will continue with the changed parameters 
 
1. Double-click with the mouse in the scale area of a 

measuring instrument or click on settings icon  
2. Change the desired parameters in the edit window. 
3. Close the window with OK or Cancel 

 

Pause or Fail event 

During Stop, Break or Event a window appears to insert a 
comment and the control panel can be used as an analysis 
tool. 

 

Test Event 

The window appears after stop or fail displays the following parameters, 
who are automatically added in the report. 

1. Enter your description to the event in the box. There are 10 indexes 
who allows to reload the last comments in the comment box. 

2. Close the window with Continue, Next or Stop 
 
Automatic registered parameters: Level, Frequency, Dwell time 
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6.4.1. Control the analysis panel 
 

Testpoint Combobox 

 
 

 
Jumps as a single step to the next or prior test point as defined in the 
testfile. The step is defined in the setup screen of the test. The next step 
uses the calibration data for the specific test point. The test parameters are 
synchronized with the regular test. 
 
 

Change Frequency 

 

 
Increase or decrease the test frequency for detailed frequency analysis 
near the test frequency. 
 
The step frequency is defined by the underlined number in the frequency 
step. In this example the console frequency step is 100kHz. 
 
Change frequency by mouse 
1. Click in the frequency display and keep the mouse. 
2. Move the pressed mouse up or down on the screen. 
 

Add to Report 

 
 

 
The Store value button sets a Marker in the Report. If you manually 
change test points, through the test, a step to the next point is 
automatically done when closing the Report box with OK. This means the 
test will continue again at the point it was interrupted. 

 
 
Change Output Level 

 

 
 
 
Increase or decrease the test power. Same behavior as the frequency 
control. 
 

Modulation 

 

Preselected settings applied by the most standards. 

 
 

Selecting “custom” opens a window to set individual modulations. 
Shape: CW, AM, PM  
Frequency: 1Hz...3000Hz step 1 Hz 
Modulation depth: 1%...99% 
 
Remark : These settings are not factory calibrated. The accuracy of 
the settings is approx. 5% 

Amplifier 

 

 
Internal:  CWS 500D / CWS 500N2 internal / CWS500N2-MF AMP1 
External: External / CWS500N2-MF AMP2 
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7. Report Window 

To open a report file (*.prj) press one of the following buttons: 
 

 
 

Change to the report window and open 
- the last test result or 
- the last edited and saved report. 

 
 

Open a file explorer to select a saved test result. 

 

Open the calibration report. 

7.1. Report Menu 

 

7.2. Report export as RTF file 

 Click on Settings to change settings on the report and format. 

 Press the button Export for export the report as a rtf file. icd.control will start a 
word processor program. In this program the user can complete the report. 

 Click on Print to view the report or print it. 
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7.2.1. Sources of the report data 

The report is composed from data of different origin. For modify the report data the user can 
- edit in the RTF file report. 
- change at the source of the data in the correspond window or file. 
 
Item Where to modify 

 

Test Center Standard report description  Test  house 
Logo 
 
Test report No 

Standard Standard manager (selected test) 

  

Test object Standard report description  Customer / EUT 
Customer 
Test engineer Standard report description  Test house 
Recorded Computer date / time 
Description Standard report description  Result 
Result 

 
 
Test plan 
 
Testfile 

Name  
Path  
Modification date  

 
Climatic condition 

Temperature Standard report description  Test house 
PathHumidity 
Pressure 

 

Test values  
Test summary  

 
Coupling device 

Model 
Sno 
Note 
Frequency range 

Origin in : Config coupling device 
Data from calibration file (created during the calibration) 

Coupling port Setup screen 

 
Diagrams 

Test Point diagram Created during a test from icd.control program 
Power 
Impedance 
Instr 1 
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Table of events 

Breaks Created during a test . Input at break or tested 
End of test 

 
Table of Test points 

Instrument Used instrument ( Description in instrument configuration 
List Measured values 

7.2.2. Import report from NSG 4070 and NSG 4060 

The icd control software allows the user to import test files stored in the NSG 4070 / 4060 generators and 
view them in the icd control software.  
In order to import the report, click on the Device Transfer button and then select the option of Read 
Generator Reports 

 
 
Then select the file you would like to view and import in icd control.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Then the report is shown as follows: 

 
It can then be saved, exported or printed as required. 
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8. Introduction Additional Monitoring 

Additional monitors are used to register the measuring values. 
The source of measuring values is any measuring equipment that has an IEEE or RS232 interface 
available. 
The measuring equipment can communicate with icd.control, i.e. icd.control can be informed in case a 
measured value exceeds the preset limit. The icd.control can react on it. 
 

 
 
The additional monitor panel communicates through the IEEE interface with the measuring equipment. 
The IEEE communication commands for the measuring equipment are explained in a command file. That 
makes the data logger independent from a specific measuring equipment. The user must know the art of 
communication commands. For this purpose, please consult the manual from the manufacturer. 

The actual measuring values can be shown in a display. The characteristic of a measuring signal 
throughout time or frequency will be shown on a diagram. The measuring values will be saved in a file 
and are ready for further adaptation. The timing for data collection of the measurement will be prepared 
by the software. These and other parameters must be configured. For this purpose the configuration 
dialogue is available. 

The additional monitor can send commands to icd.control and vice versa. That allows a flexible test set-
up. Innumerable application possibilities arise without a firm bond on one prescribed test set-up. Please 
note, that each measuring equipment needs its own IEEE-address. 

8.1. Measuring instrument 

8.1.1. Internal PM current monitor 

Depending of the model and option the following internal instruments are available: 

- Monitor input    → all other applications 

- Forward power → bi directional coupler  

- Reverse Power → bi directional coupler 
 
With the internal RF meter, it is possible to perform a current clamp test with BCI applications or where it 
is necessary to measure the current. 
 

Attention ! 
Voltages higher than 1V can destroy the measure input on 
Front side of CWS. 
 
For NSG 4070, please carefully check the connecting port 
value before making the connection. 
 
Damages caused an overvoltage of this input are excluded 
from guaranty work. 

 

 

8.1.2. External instrument 

The measuring instrument must have an interface. A measuring instrument is such instrument that can 
send back a value on request (Trigger). 

8.2. Configuration of a measuring instrument 

The simplest way to define a new instrument is to copy an existing instrument definition file. By changing 
the IEEE and diagram parameters it is simple to create a new measuring equipment. 
This can be done in the Interface Setup dialog. The default value is 10s and will be set automatically after 
creating. 
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Retrieving USB interface parameters: 

 
 
To create a new instrument, proceed according the following steps: 
 

A: Copy an existing instrument 
 

Generator Internal 
Select the check box for internal or external instrument.  
To make a instrument definition for internal measuring instrument this filter must be enabled. All 
external instruments are disabled. icd.control supports the current clamp measuring instrument. 
 

4.)  a)  Double click into the Instrument field 

b) Enter the parameters for Measurement filter, Description,  
Vertical settings, Trigger and Pass / Fail threshold  

c)  Configure the instrument commands and Interface setup 

d)  Press Save As button for save the create a new instrument name. 

 

 

B: Create a new instrument 

 

 

-  Click  and then  “New” button  
  

 

 

- Enter the interface parameters 

- Enter the control commands for control the new 
instrument. 

- With Send and Receive button , the command executes 
immediately. This is useful for test the commands. 

- Press OK button for close the window of the new 
instrument. 
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8.2.1. Instrument Timeout 

For match the icd.control instrument timeout to long dwell time, it can be necessary to adjust the timeout 
duration. This can be done in the Interface Setup dialog. 
The default value is 10s and will be set automatically after create. 
 

  
 

8.3. Configuration Dialogue 

Click the Open Instrument in the Tool button 
 
or 
 
double click in the center of the Instrument during the test. 

 
 

  
 
Dialogue window for measuring instrument parameter. 
The possibilities of entering elements remind to a cathode-ray oscilloscope (CRO) with vertical and 
horizontal deflection. 
 

 

 

 
While working with icd.control the horizontal deflection and the frequency of icd.control have to be 
synchronized. 
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8.3.1.  Buttons 

OK The settings will be applied for only this test, but are not saved for later 
measurements.  

Save As The settings will be stored and used for later measurements 
Cancel Cancel all changes 
Interface Definition of the IEEE commands 

8.3.2. Type of measurement (Create an instrument) 

Your measuring instrument has to be informed about what kind of 
measuring task (Measuring type) you assign it to. The icd.control reacts 
differently according to the task. 
There are seven measuring types to choose from. 

 

8.3.2.1. General measuring instrument 

The measuring instrument records the values in a file and put them into a diagram. According to the 
alarm settings, the measuring instrument can send an eventmessage to icd.control. For this reason, it 
reacts according to EVENTS set-up. 
See icd.control, Configuration, Reaction EVENTS 

8.3.2.2. Current clamp measuring instrument 

The measuring instrument is used for control of flowing current in the EUT. This set-up is chosen while 
working with a current clamp example closed loop controlled. When the icd.control realizes that the 

current exceeds I > Imax = Uo/150, Uo will be reduced to I <= Imax. 
The alarm - functions are disabled in this mode. Instead of that you must state U/I-factor. 

8.3.2.3. Forward Power / Reverse Power 

Measuring the forward or reverse power of a bi-directional coupler. The internal instrument gets the result 
from the built-in bi-directional coupler of the generator. 

8.3.2.4. Calibration measuring instrument (icd.control Calibration High Resolution) 

Must be set-up when doing the calibration with the monitor input or an external measuring instrument 

8.3.2.5. Field Probe 

This instrument is using a linear field probe with a fiber optic RS 232 modem. The software supports a 
frequency linearization file for the probe. 

8.3.3. Description 

Description of configuration file (*.mcf). 
 

Information about the measuring instrument and its set-up which will be sent via the interface. The text 
is displayed as instrument description when you select an instrument from the library. 
 

 

8.3.4. Trigger 

Delay 

After a successful triggering through the icd.control,  there is a preset time before the first measurement 
is released. In this case the length of the rest time must be long enough for icd.control! 
This delay allows you to wait until the transient phase of the sample is elapsed. 
Then the icd.control waits until all measuring instruments signalize the end of the measuring. Then no 
measuring errors can occur during the interval-phase. 

8.3.5. Alarm 

By exceeding the High- resp. Low level the icd.control can be alarmed. This happens by sending a Fail3-
message to the icd.control. 
 



AMETEK CTS  icd.control 
 

Operation Manual V 8.0.0 67 / 73 
 

 

High [Hi] 

Maximum allowed level. Fail3 will be released when level is exceeded. 

Low [Lo] 

Minimum allowed level. Fail3 will be released when signal goes below. 

8.3.6. Current Probe Transformer Impedance for current probe 

The icd.control anticipates that the measuring value represents a current. As a rule, the current is 
intercepted with a current-probe delivering a certain voltage as the measured value. With the help of 
the transfer impedance the data logger can convert the voltage into a current and compensate the 
frequency dependence of the clamp.  
 

For IEC measurement with a current limit icd.control matches the measuring value Iist with the 
maximum allowed current, that results from the formula  

Imax = Uo/ 150 
Iist >= Imax ? -> Uo reduced = Uo * Imax / Iist 

8.3.7. Current Probe Transfer Impedance 

The Current (transformer) clamp transfer impedance file contains the factor across the frequency band to 
convert the voltage into current. 

Refer to the manual of your clamp manufacturer to get the list of the factors, or read them out of the 
transfer curve diagram.  

The factor can be entered in Ohm or dBOhm.  
To enter the list use the TAB or SPACE bar, it expands the values 
with the unit (Hz, kHz, MHz, Ohm or dBOhm). 
Between the defined points the icd.control use a log interpolation to 
get the correct factor for each frequency. Outside of the definition, the 
nearest factor is taken. 

 

 

CWS 500C/N1 user 

If you use a CWS 500C/N1 with internal PM current monitor, icd.control make a download of the table 
with the transfer impedance to the CWS500C/N1 memory. The icd.control software uses always the 
CWS500C/N1 memory for measurement.  

It is possible to up- and download two different current clamp files to storage CP1 or CP2. For testing 
without icd.control you can use the stored current clamp file. In the window. 

8.3.7.1. Download a Current Probe Transfer Impedance to Device (CWS 500C/N1 user) 

 
1.  Select the Device Transfer button and select  

Write Current Probe Transfer Impedance 

 
 
2. Select the desired CP file After loading the transfer 

impedance characteristic file is presented on the desktop. 
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3. Select the CP Store CP1 or CP2 in the CWS  
4. Press “Write” button 
 
 
Note: The CWS 500C/N1 will limit the frequency range of the  

CP-file to 100kHz... 250kHz ( see picture after upload). 

   
  

8.4. Configuration file of measuring equipment 

This dialogue is shown if: 
1.) the key ”Interface” in the configuration dialogue is pressed. 
2.) by setting up a new measuring instrument with the selection dialogue. 
 
A measuring instrument with an interface has a set of commands. This set of commands helps the 
measuring instrument to communicate with other instruments. 
There are different standard commands in the world of IEEE488. Standard IEEE488.2 and the language 
SCPI are being mostly used. This is not mandatory in the presented case. 
The commands set the measuring instrument in an intended operating mode through the interface IEEE 
or RS232. It is possible to read information about the status and the measuring values. 
The procedure for setting up the communication as a rule is the same for all instruments. In any case 
there must be a manual of the particular measuring instrument available.  
The data logger sends first (one way/single action after start) the information from the ”Search string” 
field. 
Then (one way/single action after start) the ”Initialize string” 
And after that the ”Trigger string”. for each measurement 
 

 

1.) Interface setup: ( open with button Setup ) 
Set the IEEE-Addresses correctly (supposition for all following steps). 

Interface commands 
2.) Identification: 

Search and identify instrument at this IEEE-Address. 

3.) Initialization: 
Initializes the instrument. Set channel, measuring range, measuring size, correction i.e. 6dB. 

Receiving string 
4.) Position 

Position of the interested value in the received string. For filter the result out from the string. 

 

Check: Sends the corresponding string to the measuring instrument and displays the feedback string. 
 
The strings can be composed from various symbols, they will be sent string by string. 
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8.4.1. Filename configuration file 

The configuration file will be saved under the given name. The names will be shown in the measuring 
instrument selection table. 

8.4.2. Interface set-up 

Shows the interface configuration in a short form. 
The set-up key starts the interface configuration dialogue. 
Here you define the setting of interface to your measuring 
instrument. 

  
 
End of string : End of the received string ( LF or CR ) 
Timeout [s] : 5s...9999s values below 5s will be set 

automatically to 5s 
IEEE Interface : Instrument address (1...30 ) 
RS 232 : Interface, Baud rate Parity, Size, Stop bit  

\  

 

8.4.3. Search String 

The instrument on the configured IEEE address should identify itself. 
Command according to IEEE488: *idn?  
An instrument receiving this string goes in remote-operation and sends its denotation resp. its 
designation back. 
From now, the instrument is ready to receive further commands via IEEE-interface.  

8.4.4. Initialize String 

The instrument on the configured IEEE-address should set itself into the transmitted operating mode. 
Example for command according to SCPI: 

 volt:ac:range 1 AC-Voltage with 1V-measuring range. 

 From now on the instrument will run in the 1V-AC measuring range. 

For initialize an instrument it is possible to add more than one command in the initialize string. 
Example: *CLS 

 DISP:TEXT:CLE 
 DISP:TEXT 'DC VOLT' 
 VOLT:AC:RANGE:AUTO ON 

8.4.5. Prepare String 

The instrument on the configured IEEE-address should perform a measurement and prepare it on the 
interface. 
Command according to SCPI: func ‘volt:ac’;:read? 
Invites the measuring instrument to perform a measurement and to write the measuring result on the 
interface. 

8.4.6. Receiving String 

Sometime it is necessary to separate the characters with the values from the received return string. 
icd.control offers a function for filter out the data of interest. 
 
 

 

separator 
position in string 

 

Number of sign  Integer value range [ 0....49 ] for the position of the data  

Signature The separator character  
Can be any character or one of the offered selection [ “,”  “.”  “;”  “:” ] . 

Example Part of interest after  : 2 and ; 

Received string  : VOLTAGE 123;700;200;235LF 

Data for icd.control : 200 ( value after the second separator character ";" )  
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8.4.7. Additional parameter (optional) 

The icd.control works in RF-frequency range. For many RF-measuring instruments it is necessary to 
specify frequency at which the measurement should be done. icd.control offers two kind of commands to 
send this information to the measuring device:  
 
1. Add frequency information using for power meter 

The instrument on the configured IEEE-address should perform a measurement at the transferred 
frequency spot. The measured value must be corrected with the correction factor at the specified 
frequency. 
 

Command according to SCPI: SENS:CORR:FREF %0.2E 

Timing of the command 

 

2. Prepare used for Scopes and Spectrum analyzers 

This command is to set for example the time base of a scope depends on the actual frequency. 
icd.control offers a Math. compiler where the user can calculate the values, transferred to the instrument.  
 

Command According the instrument language 

Timing of the command 

 

Separator # is the separator for the icd.control compiler 

Functions XPARAM : Applied frequency [Hz] 
YPARAM : Applied Generator output level 
CHANNEL : Instrument channel index 

Mathematical functions Using {} allows to add the existing mathematical functions 

ADD or + : Addition 
SUB or - : Subtraction 
MUL or * : Multiplication 
DIV or / : Division 
P10 : Powers of base 10 
L10 : Logarithmic of base 10 

( )  : For prioritizing calculations 

Examples SENS:FREQ:CENT {XPARAM * 3} 
SENS:FREQ:SPAN {XPARAM * 5} 
C1:TRLV {YPARAM*400} 
TDIV {XPARAM} 

 
#  For formatting output value (needs always 2: begin and end) 
Example: gen:level {XPARAM*10#.1f#};  will be "gen:level 65.5" 

 
 

3. Wait command used for wait till the instrument is ready for the next command 
 
The software offers the following order for wait till the instrument has finished his actual process. 
Available commands for waiting: 

*OPC? waits for receiving 1 on the bus 

ICD:COM:WAIT [ms] waits a time in ms Example : ICD:COM:WAIT 500 
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4. Additional commands used to send informations to external devices as displays 
 
ICD:INIT:STANDARD  Name of the actual standard 
ICD:PARAM:FRQ  Frequency 
ICD:PARAM:LEV  Test Level 
ICD:PARAM:MOD  Modulation 
ICD:MEAS:LEV  Current Clamp Value 
ICD:MEAS:FPOW  Forward Power 
ICD:MEAS:RPOW  Reverse Power 
ICD:CAL:LEV   Calibrated Level 
ICD:CAL:FPOW  Calibrated Forward Power 
ICD:CAL:RPOW  Calibrated Reverse Power 
 
Example:"Forward Power: {ICD:MEAS:FPOW*2} dBm" 
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8.5. Report understanding the graph behavior in a report 
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8.6. CWS 500C / CWS 500N1 calibration setup for EM clamp and BCI clamp 

This chapter describes the calibration acc. IEC 61000-4-6 using a CWS 500C or a CWS 500N1.There is 
no different between the built in power meter (standard instrument or optional built in power meter PM 
402 ) .  
 
Setup 
The calibration setup is according the figure on the 

right side. The calibration setup is a 300 system 
and therefore the calibration jig is terminated with 

resistors of 150 and 100 in series with the 50 of 
the PM 402 impedance. 
 
Connect the measuring cable to the CAL INPUT on 
the rear side of the CWS 500C or CWS 500N1 

 
 
 
icd.control setup  
icd.control will make all settings automatically for calibration with clamps ( BCI or EM clamp). The figure 
shows the setting for using the generators CWS 500N1 and CWS 500N2 with different calibration setup 
for each generator model. 
 

 

 
 


